Using the Calendar
Microsoft Outlook 2016 for the PC
# Table of Contents

Introduction .......................................................................................................................... 5

Learning Objectives ............................................................................................................. 5

The Calendar Interface .......................................................................................................... 6

Accessing the Calendar ......................................................................................................... 7

Appointments .......................................................................................................................... 7

- Creating Calendar Appointments ....................................................................................... 7
- Add a Recurrence to an Appointment ................................................................................. 9
- Modifying an Appointment .................................................................................................. 10
- Deleting an Appointment .................................................................................................... 11

Meetings .................................................................................................................................. 12

- Creating Meetings .............................................................................................................. 12
  - Adding People to a Meeting from the Global Address List ........................................... 13
  - Using the Scheduling Assistant ....................................................................................... 15
- Modifying a Meeting .......................................................................................................... 16
- Canceling a Meeting ........................................................................................................... 17
- Responding to a Meeting Request .................................................................................... 19
  - Proposing a New Meeting Time ....................................................................................... 20
- Respond to a Meeting Request from the Calendar ........................................................... 20
- Suggested Meeting Times .................................................................................................. 21
  - Using Quick Steps to Create an Appointment from an Email ..................................... 23

Search Calendar Items .......................................................................................................... 25

Creating a Calendar ............................................................................................................... 26

Show/Hide Calendars ............................................................................................................ 27

Modifying Calendars ............................................................................................................. 27

Renaming Calendars .............................................................................................................. 27
Change the Color of a Calendar ................................................................. 28
Move a Calendar .......................................................................................... 28
Copy a Calendar ............................................................................................ 29
Printing a Calendar ...................................................................................... 30
Deleting a Calendar ...................................................................................... 32
Sharing a Calendar ....................................................................................... 32
Accepting Access to a Shared Calendar ..................................................... 34
Removing a Shared Calendar ...................................................................... 35
Changing Permissions on a Shared Calendar .............................................. 35
  Access Calendar Permissions ................................................................. 35
  Remove Someone from a Calendar Share .............................................. 36
  Alter Permissions on a Calendar Share .................................................. 37
Access Calendar Options ............................................................................. 38
Additional Help ............................................................................................ 39
Introduction

Microsoft Outlook is a useful tool in managing your email, schedule, contacts, and tasks. This booklet will focus on the Calendar tool in Outlook on the PC and guide you through the process of creating appointments, meeting requests, sharing your calendar, and other uses of the Calendar tool.

Learning Objectives

After completing the instructions in this booklet, you will be able to:

• Create appointments, meetings, and events.
• Add recurrences to appointments, meetings, and events.
• Modify or delete appointments, meetings, and events.
• Respond to meeting requests.
• Set up a quick step to create a calendar appointment from an email.
• Create meetings based on suggested meeting times.
• Search for calendar items.
• Show, hide, create new, and modify calendars.
• Share calendars with others and modify privileges to your existing calendar shares.
• Access your calendar options.
The Calendar Interface

1. **New**: Create a new appointment or new meeting (See Figure 1).
2. **Go To**: Move calendar to show today’s events, or events for the next 7 days from today (See Figure 1).
3. **Arrange**: Choose from displaying your events in day, work week, week, month, or schedule view (See Figure 1).
4. **Tell Me Bar**: Look up Outlook tools, get help, or search the web (See Figure 1).
5. **Share**: Set up calendar shares and manage view/edit permissions (See Figure 1).
6. **Current Month**: Quickly jump between months to view past/future entries (See Figure 1).
7. **Weather**: Lists upcoming weather for your selected area (See Figure 1).
8. **Search Calendar**: Search your calendar for past/future events (See Figure 1).
9. **Active Calendars**: Shows the calendars that are currently being viewed. Can be displayed as overlapping (currently shown) or broken out to show individual events (See Figure 1).
10. **Calendar List**: Shows all calendars you have created or received shares for (See Figure 1).
11. **Calendar**: Displays appointments/meetings/events for all calendars selected from the Calendar List (See Figure 1).
12. **Navigation Bar**: Access the other tools within Outlook such as the Inbox, Calendar, People, or Tasks tools (See Figure 1).
Accessing the Calendar

The calendar can easily be accessed on the *Folder Pane* from within any tool in Outlook (e.g. Inbox, Tasks, People, etc.). To access the calendar, click the *Calendar* icon on the *Folder Pane*.

Figure 2 - Accessing Calendar

Appointments

An appointment is a scheduled block of time that only involves you, and does not include other attendees or resources. The following section will explain how to set up appointments and how to manage existing ones:

Creating Calendar Appointments

1. In the *Ribbon* under the *Home* tab, click *New Appointment*.

Figure 3 - Click New Appointment

*Note*: You can also double-click a blank *time/date* on your calendar to open the *New Appointment* window.
2. The New Appointment window will open:
   a. **Subject**: Enter the subject of your appointment (See Figure 4).
   b. **Location**: Enter where the appointment will take place (See Figure 4).
   c. **Start Date and Time**: Enter the date and time the appointment will start (See Figure 4).
   d. **End Date and Time**: Enter the date and time the appointment will end (See Figure 4).
   e. **Message**: Enter any message that you would like to attach to the appointment (e.g. notes, links, pictures, etc.) (See Figure 4).
   f. **Show as**: Will set your status in the calendar during the appointment time (See Figure 4).
   g. **Reminder**: Set if you wish to receive a reminder before the appointment begins (See Figure 4).
   h. **Tags**: Use to mark your appointment as high/low importance, or private (See Figure 4).

![Figure 4 - Appointment Details](image)

3. When adding details to your appointment, click **Save & Close**.

![Figure 5 - Save & Close](image)

4. Your new appointment will now appear on your calendar.

![Figure 6 - Appointment Added to Calendar](image)
Note: Once an appointment or meeting goes over 24 hours, it becomes an event and is shown as a banner at the top of the date(s) on which it occurs.

Add a Recurrence to an Appointment

If an appointment will occur multiple times on your calendar, you can create it as a recurrence. The following will use the example of setting an appointment that will occur weekly at the same time for approximately two months:

1. While creating a new appointment (or event/meeting), click the recurrence button under the Appointment tab.

2. The Appointment Recurrence window will appear:
   a. Appointment Time: Enter the start/end times for the appointment (See Figure 9).
   b. Recurrence Pattern: Enter whether the appointment will occur Daily, Weekly, Monthly, or Yearly, and how often it will occur within that time frame (See Figure 9).
   c. Range of Recurrence: Enter the start date, and when the appointment should end (See Figure 9).

3. Click OK.
4. The recurrence will be set and the occurrence will be displayed under Location in your appointment.

![Figure 10 - Recurrence Set](image)

**Modifying an Appointment**

The following section will explain how to modify existing appointments. For this example, we will change the date and time of an existing lunch appointment:

1. Access your calendar in Outlook.
2. Double-click the calendar appointment you wish to modify.

![Figure 11 - Select Calendar Appointment](image)

3. The Appointment window will appear and display the details of the appointment. Adjust the Start/End time of the appointment (See Figure 12).

4. Click Save & Close (See Figure 12).

![Figure 12 - Modify Appointment Details](image)

5. The appointment will be updated.
Note: If you only have to change the date/time of an appointment, you can also left-click & drag the appointment on the calendar to a desired timeslot.

Deleting an Appointment

To delete an existing appointment:

1. Access your calendar in Outlook.
2. Right-click the calendar appointment you wish to delete.
3. Additional options will display. Select Delete.
4. The selected appointment will be removed from your calendar.
Meetings
A meeting is an activity that involves you and others during the same blocked time period, and can affect the calendars of other people included in the meeting. The following section will explain how to set up meetings and how to manage existing ones:

Creating Meetings
1. In the Ribbon under the Home tab, click New Meeting.

2. The New Meeting window will open:
   a. **To**: Enter the names or email addresses of individuals who you wish to include in your meeting (See Figure 17).
   b. **Subject**: Enter the subject of your meeting (See Figure 17).
   c. **Location**: Enter where the meeting will take place (See Figure 17).
   d. **Start Date and Time**: Enter the date and time the meeting will start (See Figure 17).
   e. **End Date and Time**: Enter the date and time the meeting will end (See Figure 17).
   f. **Message**: Enter any message that you would like to attach to the meeting (e.g. notes, links, pictures, etc.) (See Figure 17).
   g. **Show as**: Will set the status for attendees in the calendar during the meeting time (See Figure 17).
   h. **Reminder**: Set if you wish attendees to receive a reminder before the meeting (See Figure 17).
   i. **Tags**: Use to mark the meeting as high/low importance, or private (See Figure 17).
3. After you finished adding details to your meeting, click **Send**.

![Figure 18 - Send](image)

4. Your new meeting will now appear on your calendar.

![Figure 19 - Appointment Added to Calendar](image)

**Adding People to a Meeting from the Global Address List**

While creating your meeting you can access the global address list to look up someone’s name at KSU.

1. While creating a new meeting request (see *Creating Meetings*), click **To:**.

![Figure 20 - To:](image)
2. The *Global Address List* appears. In the *Search* field, enter the **name** of someone you wish to search for (See Figure 21).

3. The search results will auto populate. Click a result to select it (See Figure 21).

4. Click one of the following fields to add the contact to the selected field (See Figure 21):
   a. **Required**: These people are important to the meeting and attendance is required (See Figure 21).
   b. **Optional**: Attendance at the meeting is optional for these people (See Figure 21).
   c. **Resources**: These people are listed as resources, and are not required to attend (See Figure 21).

5. When you are finished adding people, click **OK** (See Figure 21).

![Figure 21 - Global Address List](image)

6. The names will be added to your meeting. Click **Send** to email the calendar invite to the attendees.

![Figure 22 - Send Meeting Invitation](image)

**Note:** To delete names from a meeting invitation, simply select their names in the *To*: field, and delete them.

7. Outlook will send a meeting invitation that will appear in the attendee’s inbox, and mark the time on their calendar as tentative.
Using the Scheduling Assistant

The scheduling assistant can help you find the best time for a meeting by displaying when recipients and meeting resources (e.g. rooms) are available.

1. After entering the information related to your meeting, click the Scheduling Assistant.

Note: For information on creating meetings, see the Creating Meetings section.

2. The Scheduling Assistant will open and display the following:
   a. Attendee Calendar: Displays upcoming items on an attendee calendar (See Figure 24).

   Note: The attendee calendar will only indicate if the attendee has an event marked on the calendar, and will not disclose what the event is.

   b. Start/End Times: Lists the start/end times for the meeting (See Figure 24).

   c. Legend: Displays the markings for attendee status on the calendar (See Figure 24).
3. You can switch back to the Appointment view by clicking Appointment (See Figure 25).

4. If you are ready to send the meeting invitation, click Send (See Figure 25).

![Figure 25 - Send](image)

### Modifying a Meeting

The following section will explain how to modify existing meetings. For this example, we will change the date and time of an existing meeting:

1. Access your calendar in Outlook.
2. Double-click the calendar appointment you wish to modify.

![Figure 26 - Select Calendar Appointment](image)

3. The Appointment window will appear and display the details of the appointment. Adjust the Start/End time of the appointment (See Figure 27).

4. Click Save & Close (See Figure 27).

![Figure 27 - Modify Meeting Details](image)

5. The appointment will be updated.
**Note:** If you only have to change the date/time of a meeting, you can also **left-click & drag** the meeting on the calendar to a desired timeslot.

![Figure 28 - Dragging Meeting to Reschedule](image)

**Canceling a Meeting**

To cancel an existing meeting:

1. Access your **calendar** in *Outlook*.
2. Right-click the **calendar meeting** you wish to delete.

![Figure 29 - Select Calendar Meeting](image)

3. Additional options will display. Select **Cancel Meeting**.

![Figure 30 – Cancel Meeting](image)
4. The *Meeting* window will open. If you wish, type a **cancelation message** in the message body (See Figure 31).

5. Click **Send Cancelation** (See Figure 31).

![Figure 31 - Edit Cancelation Message](image)

6. The cancelation message will be sent to all meeting attendees, and the meeting will be removed from their calendars.
Responding to a Meeting Request

When someone sends you a meeting request, it will appear in your inbox as an email. Details regarding the event will be displayed within the email with additional options for responding to the request. To respond to a meeting request:

1. Access your **inbox** and select the meeting request you wish to respond to (See Figure 32).
2. Additional details will be displayed in the email with a preview of your calendar (See Figure 32).
3. Click **Accept** to accept the meeting request and add it to your calendar (See Figure 32).
4. Click **Tentative** to mark the meeting request as tentative and add it to your calendar (See Figure 32).
5. Click **Decline** to deny the meeting request (See Figure 32).
6. Click **Propose New Time** to either reply with a tentative or denial of the original request, and send attendees a new meeting time (See Figure 32).
7. Click **Calendar** to view the meeting in your calendar (See Figure 32).

8. Clicking **Accept**, **Tentative**, or **Decline** will bring up additional options for responding to a meeting request:
   a. **Edit the Response before Sending**: Allows you to add a message that will be sent to the organizer of the meeting (See Figure 33).
   b. **Send the Response Now**: Will send the default acceptance/tentative/denial message to the organizer of the meeting (See Figure 33).
   c. **Do Not Send a Response**: Will not send a message to the organizer of the meeting (See Figure 33).
Proposing a New Meeting Time

When you receive a meeting request, you can choose to propose a new meeting time:

1. Clicking Propose New Time will bring up additional options for proposing a new time (See Figure 32):
   a. Tentative and Propose New Time: Marks the current time as tentative on your calendar and opens the scheduling assistant to select a new time (See Figure 34).
   b. Decline and Propose New Time: Denies the current meeting request and opens the scheduling assistant to select a new time (See Figure 34).

2. After making a selection, the Propose New Time window will open and display the calendars of all participating attendees (See Figure 35).
   a. Under Meeting Start/End Time, select a new time and date to propose (See Figure 35).
   b. Click Propose Time (See Figure 35).

3. The new meeting time will be sent to the meeting organizer.

Respond to a Meeting Request from the Calendar

When someone sends you a meeting request, it will also appear on your calendar as tentative. To respond to a meeting request from your calendar:

1. Click the meeting time of the request on your calendar.
2. Additional options will appear in the *Ribbon* under the *Calendar Tools – Meeting* tab:
   a. **Accept**: accept the meeting request and add it to your calendar (See Figure 37).
   b. **Tentative**: mark the meeting request as tentative and add it to your calendar (See Figure 37).
   c. **Decline**: deny the meeting request (See Figure 37).
   d. **Propose New Time**: reply with a tentative or denial of the original request, and send attendees a new meeting time (See Figure 37).
   e. **Respond**: draft an email with the meeting information as the topic (See Figure 37).

![Figure 37 - Calendar Tools - Meeting Tab](image)

3. Clicking **Accept**, **Tentative**, or **Decline** will bring up additional options for responding to a meeting request:
   a. **Edit the Response before Sending**: Allows you to add a message that will be sent to the organizer of the meeting (See Figure 38).
   b. **Send the Response Now**: Will send the default acceptance/tentative/denial message to the organizer of the meeting (See Figure 38).
   c. **Do Not Send a Response**: Will not send a message to the organizer of the meeting (See Figure 38).

![Figure 38 - Meeting Request Response Options](image)

**Note**: See the section on *Proposing a New Meeting Time* for more information on proposing a new meeting time.

**Suggested Meeting Times**

Microsoft Outlook 2016 for the PC will check received emails for potential meeting times and dates. If it finds something that it thinks could be a meeting request, it will mark the top of the email content with *Suggested Meetings*. You can then use this to create a calendar meeting from the message.
The following will use an example of an email requesting a meeting on a Wednesday at 2pm:

1. If Microsoft Outlook 2016 for the PC identifies a potential meeting time/date, the text *Suggested Meetings* will appear above the message. Click *Suggested Meetings*.

![Figure 39 - Suggested Meetings](image)

2. The *Suggested Meetings* window will open within the email:

   **Note:** The *When* and *Who* fields may be automatically populated if Microsoft Outlook detects the information in the message (See Figure 40).

   a. **Where:** Enter the location the event will take place (See Figure 40).
   b. **Edit Details:** Click to edit details of the suggested meeting (See Figure 40).

   **Note:** Refer to number 2 in the section on *Creating Meetings* for more information on editing your meeting information.

![Figure 40 - Suggested Meeting Confirmation](image)

3. Click **Schedule Event** when you are ready to confirm the meeting information.

![Figure 41 - Schedule Event](image)

4. The meeting will be added to your calendar, and a confirmation message will be displayed.
Using Quick Steps to Create an Appointment from an Email

Sometimes an email will contain important information that can help when referencing meeting details. You can set up a Quick Step command that will create an appointment from an email message. The following will explain how to set up the Quick Step command that will be used to create appointments from emails:

1. Right-click any email within your inbox (See Figure 42).
2. From the menu, click Quick Steps (See Figure 42).
3. Click Manage Quick Steps... (See Figure 42).

4. The Manage Quick Steps window will open. Click New (See Figure 43).
5. Click Custom (See Figure 43).
6. The *Edit Quick Step* window will appear:
   a. In the *Name* field, type a **name** to call your quick step (See Figure 44).
   b. From the drop-down, select **Create an appointment with text of message** (See Figure 44).
   c. Click **Finish** (See Figure 44).

![Figure 44 - Create an Appointment with Text of Message](image)

7. You will be returned to the *Manage Quick Steps* window. Click **OK** to close it.

8. Your new **Quick Step** is now ready. To use your Quick Step:
   a. Right-click the **desired email** within your inbox (See Figure 45).
   b. From the menu, click **Quick Steps** (See Figure 45).
   c. Click your newly created **Quick Step** (e.g. *create appointment*) (See Figure 45).

![Figure 45 - Using a Quick Step](image)

9. The **new appointment window** will open and you can continue creating your calendar appointment
   (see step 2 under *Creating Calendar Appointments* for more information).
Search Calendar Items

If you need to find an appointment, meeting, or event on your calendar, you can use the search feature to search your whole calendar for a keyword or phrase.

1. From your Calendar, type your **search parameters** in the *Search Calendar* field.

![Figure 46 - Search Calendar](image)

2. Your search will auto-populate below the search field and list all items that match your search parameters.

![Figure 47 - Search Results](image)

3. To close the search and return to the calendar view, click **Close Search** in the *Ribbon*.

![Figure 48 - Close Search](image)
Creating a Calendar

You can create a calendar to track different types of appointments (e.g. if you want to keep your personal appointments separate from your KSU appointments).

1. After accessing your calendar, click **Open Calendar** in the **Ribbon** (See Figure 49).
2. From the drop-down, click **Create New Blank Calendar** (See Figure 49).

![Figure 49 - Create New Blank Calendar](image)

3. The **Create New Folder** window opens. In the **Name** field, type a **name** for the calendar (See Figure 50).
4. Click **OK** (See Figure 50).

![Figure 50 - Create New Folder](image)

5. The new calendar will be created and displayed under **My Calendars**.

![Figure 51 - My Calendars](image)
Show/Hide Calendars

Calendars that you have access to view and/or edit are visible on the folder pane in the Calendar view. Calendars that are currently displayed will be checked and color coded, while calendars that are hidden will not have a check next to them.

1. To show/hide your calendars, simply click the checkbox next to the desired calendar to show or hide it.

![Show/Hide Calendars](Figure 52 - Show/Hide Calendars)

Modifying Calendars

The following section will demonstrate some ways you can modify your calendars and change your calendar view:

Renaming Calendars

1. From the Calendar view, right-click the Calendar you wish to rename (See Figure 53).
2. Click Rename Calendar (See Figure 53).

![Rename Calendar](Figure 53 - Rename Calendar)
3. The selected calendar will turn into a text field. Type the **name** you wish to give the calendar.

![Image of calendar with name field](image1)

**Figure 54 - Renaming Calendar**

4. Press **enter** to confirm.

**Change the Color of a Calendar**

1. From the **Calendar** view, right-click the **Calendar** you wish to change the color of (See Figure 55).
2. Click **Color** (See Figure 55).
3. From the list of colors displayed, click a **color** (See Figure 55).

![Image of calendar color change](image2)

**Figure 55 - Changing the Calendar Color**

4. Your new calendar color will be set.

**Note:** You may have to hide then show your calendar for the change to display.

**Move a Calendar**

1. From the **Calendar** view, left-click and hold the calendar you wish to move (See Figure 56).
2. Drag the selected calendar to its new location (See Figure 56).

![Image of calendar being moved](image3)

**Figure 56 - Move Calendar**

3. Release the left mouse button, and the calendar will move to the select location.
Copy a Calendar

1. From the *Calendar* view, right-click the *Calendar* you wish to copy (See Figure 57).
2. Click *Copy Calendar* (See Figure 57).

![Figure 57 - Copy Calendar]

3. The *Copy Folder* window appear. Select *Calendar* from the list of folders (See Figure 58).
4. Click *OK* (See Figure 58).

![Figure 58 - Copy Folder Window]

5. The selected calendar will be copied and appear under *My Calendars* in the *Folder Pane*. 
Printing a Calendar

The following will explain how to create a printout of your calendar:

1. From the Calendar view, make sure all calendars you wish to print are currently marked as shown in the Folder Pane (See Figure 59).
2. In the Ribbon, click the File tab (See Figure 59).

3. The Backstage View opens. Click Print (See Figure 60).
4. Select a printer from your list of available printers (See Figure 60).
5. A preview of your calendar will display, showing you all calendar items that are visible on your calendar (See Figure 60).
6. Under Settings, select a Printout Style (See Figure 60).

Note: Selecting the different styles will generate a preview of how your printout will look.

7. Click Print Options to access additional settings (See Figure 60).
8. The *Additional Print Options* window will open. Under *Print this calendar*, select a **calendar** you wish to print out (See Figure 61).

**Note:** Available calendars displayed under *Print this calendar* will change based on which calendars are currently shown in your *Calendar view*.

9. Under **Print Range**, select the **Start/End dates** of the calendar items you wish to print (See Figure 61).
10. Click the **checkbox** next to **Hide details of private appointments** (*optional*) (See Figure 61).
11. Click **Print** (See Figure 61).

12. Your print job will be sent to your selected printer.
Deleting a Calendar

To delete a calendar you have created:

1. Access the Calendar view.
2. In the Folder Pane under My Calendars, right-click the Calendar to be removed (See Figure 62).
3. Click Delete Calendar (See Figure 62).

4. The selected calendar will be removed.

Sharing a Calendar

You can share your calendars with others when you want others to have access to your schedule. When sharing, you can determine the level of control others will have over your calendar. To share a calendar with a colleague:

1. From the Calendar view, select a calendar from the folder pane (See Figure 63).
2. In the Ribbon under the Home tab, click Share Calendar (See Figure 63).
3. The *Sharing Request* window will appear. In the *To* field, type the name of the individual(s) you wish to send the calendar share to (See Figure 64).

4. Click *Request permission to view recipient’s Calendar* if you wish the recipient to share their calendar with you as well (See Figure 64).

5. Make sure the *Allow recipient to view your Calendar* box is checked (See Figure 64).

6. In the *Details* field, select one of the following options (See Figure 64):
   a. **Availability Only**: Time on your calendar will only be shown as *Free, Busy, Tentative, Working Elsewhere, or Out of Office* to the recipient (See Figure 64).
   b. **Limited Details**: Will include the availability and subjects of calendar items only (See Figure 64).
   c. **Full Details**: Will include the availability and full details of calendar items (See Figure 64).

7. If you wish to send a message along with the share, enter it in the message field below (See Figure 64).

8. Click *Send* to send the calendar share to the individuals listed in the *To* field (See Figure 64).

9. A confirmation message will appear. Click *Yes*.
Accepting Access to a Shared Calendar

When you are sent a calendar share, you will receive an email in your inbox with an option to accept the share.

1. From your *Inbox*, select the email with the sharing invitation (See Figure 66).
2. At the top of the email, click **Open this Calendar** (See Figure 66).

![Figure 66 - Open this Calendar](image)

3. The *Calendar* view will open and the shared calendar will be added to your *Shared Calendars* in the *Folder Pane*.

![Figure 67 - Calendar Share Added](image)
Removing a Shared Calendar

To remove a calendar that has been shared with you:

1. Access the Calendar view.
2. In the Folder Pane under Shared Calendars, right-click the Calendar to be removed (See Figure 68).
3. Click Delete Calendar (See Figure 68).
4. The shared calendar will be removed.

Changing Permissions on a Shared Calendar

The following will show how to adjust Calendar access and permissions to an existing calendar share you have sent to another person:

Access Calendar Permissions

1. From the Calendar View, click on Calendar Permissions under the Home tab in the Ribbon.
Remove Someone from a Calendar Share

1. After accessing the Calendar Properties, select the user name you wish to remove (See Figure 70).
2. Click Remove. The selected user name will be removed from the list (See Figure 70).
3. Click Apply to apply the change (See Figure 70).
4. Click OK to close the window (See Figure 70).

Figure 70 - Calendar Properties: Remove
Alter Permissions on a Calendar Share

1. After accessing the Calendar Properties, select the user name you wish to alter (See Figure 71).
2. In the Permission Level drop-down, select a permission level to apply (See Figure 71).
3. Click Apply to apply the change (See Figure 71).
4. Click OK to close the window (See Figure 71).

![Figure 71 - Calendar Properties: Permission Level](image)

Note: The list of Permission Levels available include:

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Owner</td>
<td>Create, read, modify, and delete all items and files, and create sub-folders. As the folder owner, you can change the permission levels others have for the folder (Does not apply to delegates).</td>
</tr>
<tr>
<td>Publishing Editor</td>
<td>Create, read, modify, and delete all items and files, and create sub-folders. (Does not apply to delegates.)</td>
</tr>
<tr>
<td>Editor</td>
<td>Create, read, modify, and delete all items and files.</td>
</tr>
<tr>
<td>Publishing Author</td>
<td>Create and read items and files, create sub-folders, and modify and delete items and files you create. (Does not apply to delegates.)</td>
</tr>
<tr>
<td>Author</td>
<td>Create and read items and files, and modify and delete items and files you create. (Does not apply to delegates.)</td>
</tr>
<tr>
<td>Nonediting Author</td>
<td>Full read details. Create items. Delete own items. Folder visible.</td>
</tr>
<tr>
<td>Reviewer</td>
<td>Read items and files only.</td>
</tr>
<tr>
<td>Contributor</td>
<td>Create items and files only. The contents of the folder do not appear. (Does not apply to delegates.)</td>
</tr>
<tr>
<td>Free/Busy Time, Subject, Location</td>
<td>Show Free/Busy Time, Subject and Location information only.</td>
</tr>
<tr>
<td>Free/Busy Time</td>
<td>Show Free/Busy Time only.</td>
</tr>
</tbody>
</table>
Access Calendar Options

You can access your Microsoft Outlook Calendar Options to change default settings such as your work hours, when the default reminder time is, time zones, display options, and more. To access your calendar options:

1. On the *Ribbon*, click *File*.

![Figure 72 - Access File Tab]

2. The *Backstage View* will open. Click *Options*.

![Figure 73 - Options]
3. The Outlook Options window will open. Click Calendar (See Figure 74).
4. The Calendar Options will display. Here you can make your desired changes by setting the options displayed (See Figure 74).
5. When finished, click OK to confirm your new settings (See Figure 74).

Figure 74 - Calendar Options

Additional Help

For additional support, please contact the KSU Service Desk:

KSU Service Desk for Faculty & Staff

- Phone: 470-578-6999
- Email: service@kennesaw.edu
- Website: http://uits.kennesaw.edu